
RELEASE NOTES

NI Requirements Gateway
Version 1.1

These release notes contain NI Requirements Gateway 1.1 system 
requirements, installation instructions, information about new features, 
and other changes since Requirements Gateway 1.0.
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Getting Started
The best way to familiarize yourself with Requirements Gateway is to 
explore the Guide to Requirements Gateway Documentation topic in the 
NI Requirements Gateway Help, which contains links to all the 
Requirements Gateway documentation in electronic format. Select 
Start»All Programs»National Instruments»Requirements 
Gateway x.x»Documentation»NI Requirements Gateway Help or 
select Help»Help Topics in the Requirements Gateway main window to 
access the NI Requirements Gateway Help.

Recommended System Requirements
National Instruments recommends the following minimum system 
requirements to run Requirements Gateway 1.1: 

• Microsoft Windows 2000 Service Pack 3 or later, Windows XP 
Service Pack 2 or later, or Windows Vista (32- and 64-bit) Business, 
Enterprise, or Ultimate Service Pack 1

• Pentium 4/M or equivalent processor (Pentium III, Celeron 866 Mhz, 
or equivalent minimum)

• 256 MB of memory

• 70 MB of free hard disk space 

• SVGA resolution or higher video adapter (800 × 600 minimum video 
resolution)

• Microsoft Internet Explorer 6.0 or later

• Microsoft-compatible mouse

Use the following National Instruments application development 
environments (ADEs) with Requirements Gateway 1.1:

• LabVIEW 7.1.1 or later

• LabWindows™/CVI™ 7.0 or later

• NI TestStand 3.1 or later

• MATRIXx 7.1.6, 7.1.7, or 7.1.8

Requirements Gateway 1.1 is compatible with the following third-party 
products:

• Telelogic DOORS 7.1 or later

(Windows Vista) DOORS 9.0 or later

• IBM Rational RequisitePro 2003 or later
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• Microsoft Word 2003 or later

• Microsoft Excel 2003 or later

• Microsoft Access 2003 or later

• Microsoft Visio 2003 or later

Note Requirements Gateway 1.1 was not tested for compatibility with other versions of 
these third-party products but should be compatible with other versions.

Requirements Gateway exposes an ActiveX interface, but the interface is 
intended for internal use only and is not supported. National Instruments 
reserves the right to remove or alter the interface without notice in the 
future.

Refer to the Known Issues section of the Readme.html file, located on the 
Requirements Gateway CD and in the <Requirements Gateway>\Doc 
directory, for possible solutions to any problems you might encounter while 
installing Requirements Gateway.

Installation Instructions
Unless you specify another location during installation, the Requirements 
Gateway installation program copies files to <Program Files>\
National Instruments\Requirements Gateway x.x.

National Instruments recommends exiting all programs before running the 
Requirements Gateway installer. Applications that run in the background, 
such as virus scanning utilities, might cause the installer to take longer than 
average to complete. 

Note You must log in as a user with administrator privileges to install Requirements 
Gateway and when a reboot is requested.

Complete the following steps to install Requirements Gateway.

1. Insert the Requirements Gateway CD into the CD-ROM drive. If the 
CD startup screen is not visible, select Start»Run and run setup.exe 
from your CD.

2. Follow the instructions in the dialog boxes.
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Activating Requirements Gateway Licenses
After you install Requirements Gateway, you must use the NI Activation 
Wizard to activate the software.

Note When you activate Requirements Gateway 1.1, you need the product serial number 
and the name of the product for the serial number. You can find both of these items on the 
proof-of-ownership and registration card you received with the product.

Refer to the Activating Your Software topic in the NI Requirements 
Gateway Help for more information about how to activate 
Requirements Gateway.

If you do not activate a valid license, Requirements Gateway runs in 
Evaluation Mode and continues to prompt you to activate a license on each 
subsequent launch. In Evaluation Mode, you can use all the features of the 
product for 30 days. After the 30-day evaluation period expires, you must 
use the NI Activation Wizard to activate a valid license to continue using 
the software.

Note This section is designed to assist you in understanding the licensing policies for 
NI Requirements Gateway. This document does not replace the National Instruments 
Software License Agreement and should only be used as a reference.

Upgrading
When you upgrade to a new version of Requirements Gateway, you can 
install the new version on the same computer that already has an existing 
version of Requirements Gateway installed. Use the Requirements 
Gateway Install Utility to configure the active version of Requirements 
Gateway when you install or uninstall a particular version of Requirements 
Gateway.

Installing Multiple Versions of Requirements Gateway on 
the Same Computer

You can install Requirements Gateway on a computer that contains a 
previous Requirements Gateway version, but you cannot install 
Requirements Gateway 1.1 over a previous Requirements Gateway 
version. You must first uninstall a previous Requirements Gateway version 
to install Requirements Gateway 1.1 in the same directory.
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Requirements Gateway Install Utility
Although you can install Requirements Gateway 1.1 on a computer that 
contains a previous Requirements Gateway version, only one version of 
Requirements Gateway can be active at a time. If you must install 
Requirements Gateway 1.1 on the same computer as a previous 
Requirements Gateway version, use the Requirements Gateway Install 
Utility to specify the active version of Requirements Gateway. Select 
Start»All Programs»National Instruments»Requirements Gateway»
Requirements Gateway x.x»Install Utility to launch the Requirements 
Gateway Install Utility application, which is located at C:\Program 
Files\National Instruments\Shared\NIRGUtility\

NIRGUtility.exe.

(Windows Vista) Windows Vista launches a User Account Control (UAC) 
elevation prompt for you to manually resolve when you launch the 
Requirements Gateway Install Utility.

Note You must always use the Requirements Gateway Install Utility to configure the 
version of Requirements Gateway you want to use after uninstalling a different version of 
Requirements Gateway. If you do not run the Requirements Gateway Install Utility after 
uninstalling a particular version of Requirements Gateway, the remaining version of 
Requirements Gateway no longer associates with the existing Requirements Gateway files.

Directory Relocation
To comply with Windows Vista restrictions on writing to the 
Program Files directory and to improve usability for 
Windows 2000/XP users who do not have permission to write to the 
Program Files directory, Requirements Gateway 1.1 installs some files 
in different locations from Requirements Gateway 1.0. 

Table 1 lists the previous directory locations in Requirements Gateway 1.0 
and the new locations in Requirements Gateway 1.1. The Requirements 
Gateway documentation and Table 1 refer to these directories in the 
following ways:

• <Requirements Gateway>—Located by default at 
C:\Program Files\National Instruments\Requirements 

Gateway x.x on Windows 2000/XP and Windows Vista (32-bit) and 
at C:\Program Files (x86)\National Instruments\

Requirements Gateway x.x on Windows Vista (64-bit).
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• <Requirements Gateway Public>—Located by default at 
C:\Documents and Settings\All Users\Documents\

National Instruments\Requirements Gateway x.x on 
Windows 2000/XP and at C:\Users\Public\Documents\
National Instruments\Requirements Gateway x.x on 
Windows Vista.

The <Requirements Gateway Public> directory also contains a 
Config subdirectory. Refer to the <Requirements Gateway 
Public>\Config Directory section for information about the Config 
subdirectory.

<Requirements Gateway Public>\Config Directory
In addition to the Examples and Tutorial subdirectories, the 
<Requirements Gateway Public> directory also contains a Config 
subdirectory that contains doc_models, doc_templates, images, and 
types subdirectories. These subdirectories are writable copies of the 
read-only subdirectories in the <Requirements Gateway>\config 
directory.

doc_models Subdirectory
When you use the Reports pane of the Configuration dialog box to create a 
custom report, Requirements Gateway stores the report in the same 
directory as the project. You can also place the report in the Public Reports 
folder in the Report List on the Reports pane. The Public Reports folder is 
accessible for all projects, and Requirements Gateway stores the report 
structures for the Public Reports folder in <Requirements Gateway 

Public>\Config\doc_models\Public Reports.xml. 
The <Requirements Gateway>\config\doc_models\

Library Reports.xml file contains the report structures for the built-in 
reports, which are read-only. Refer to Chapter 4, Generating Reports, of 
the Getting Started with NI Requirements Gateway manual and Chapter 4, 
Customizing Reports, of the NI Requirements Gateway Customization 
Guide for more information about customizing reports.

Table 1.  Requirements Gateway Directory Relocation

Location in Requirements Gateway 1.0 Location in Requirements Gateway 1.1

<Requirements Gateway>\Examples <Requirements Gateway Public>\Examples

<Requirements Gateway>\Tutorial <Requirements Gateway Public>\Tutorial
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doc_templates Subdirectory
The <Requirements Gateway Public>\Config\doc_templates 
directory contains the custom templates for report formats that you want to 
make available for all projects. The custom template becomes available 
from the Template ring control on the Reports pane of the Configuration 
dialog box and from the Save As dialog box when you generate a report. 
This directory is empty by default. Refer to the NI Requirements Gateway 
Help for more information about using and customizing report templates.

images Subdirectory
The <Requirements Gateway Public>\Config\images directory 
contains custom bitmap files that you can use as icons for custom types or 
type elements. The bitmap file must be 16 x 16 pixels and you must include 
a corresponding mask icon. Requirements Gateway uses the icon files in 
this directory and the <Requirements Gateway>\config\images 
directory to populate the Select icon dialog box, which you can launch by 
clicking the Icon button on the Types pane of the Configuration dialog box 
for a custom type or type element. The <Requirements Gateway 
Public>\Config\images directory is empty by default. Refer to the 
NI Requirements Gateway Help for more information about the options on 
the Types pane and using icons for custom types.

types Subdirectory
When you use the Types pane of the Configuration dialog box to create a 
custom type, Requirements Gateway stores the type information in the 
same directory as the project. You can also place the type in the public 
folder in the Types List on the Types pane. The public folder is accessible 
for all projects, and Requirements Gateway stores the type definitions for 
the public folder in <Requirements Gateway Public>\Config\

types\public\public.types. The built-in types files in the 
<Requirements Gateway>\config\types directory are read-only, 
and you cannot edit the default type definitions on the Types pane of the 
Configuration dialog box. Refer to Chapter 5, Customizing Types, of the 
Getting Started with NI Requirements Gateway manual and Chapter 2, 
Customizing Types and Type Elements, of the NI Requirements Gateway 
Customization Guide for more information about creating custom types. 

What’s New in Requirements Gateway 1.1
New features in Requirements Gateway 1.1 include marks, the type for 
added elements, changes to existing types, the new Checksum type, 
compatibility with Windows Vista, and other enhancements since 
Requirements Gateway 1.0.
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Marks
In Requirements Gateway 1.0, each time you reload a project, orange icons 
indicate the differences detected since the last time you opened the project. 
Requirements Gateway displays the icons only the first time you reload 
after you make a change. The icons disappear if you reanalyze the project 
without modifying any documents.

In Requirements Gateway 1.1, you can apply permanent marks to elements 
so that you can continue to modify and reload a project several times and 
track the modified elements across several iterations of a project 
configuration. You can also apply marks to the results of a search that you 
perform when you select Edit»Find in the main window. All marks persist 
until you manually remove them.

Refer to the NI Requirements Gateway Help for more information about 
using marks in a project.

Type for Added Elements
Types define the traceability information you can add to a document, such 
as references, attributes, links, and text. The type applied to a document 
defines the required syntax that must exist in a document or in an 
intermediate file for a document in order for Requirements Gateway to 
properly analyze traceability information.

You can create and use a type for added elements in a project to allow users 
to directly add traceability elements in Requirements Gateway without 
requiring you to edit an original document. You must configure a project 
document to use a modification document that uses a type for added 
elements. Requirements Gateway provides options in the context menus of 
the views in the main window for adding the elements to the document. 
Requirements Gateway stores added element information directly in the 
modification document.

You can use a type for added elements to modify one or more documents in 
a project without requiring you to customize default types or modify an 
original project document.

Just as with the default types, you can save the type for added elements in 
a public directory so you can reuse the type for all projects.

Refer to the NI Requirements Gateway Help for more information about 
creating and configuring a type for added elements, adding the type to a 
project, and using modification documents.
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Changes to Existing Types
Requirements Gateway 1.1 updates the LabVIEW, NI TestStand, 
Microsoft Word, Microsoft Excel, Microsoft Access, Telelogic DOORS, 
and Code C types.

LabVIEW
If your project used LabVIEW documents or if you created snapshots of a 
project that used LabVIEW documents, you must reanalyze the project in 
Requirements Gateway 1.1. The structure of the XML in the intermediate 
file in Requirements Gateway 1.1 differs from the structure in 
Requirements Gateway 1.0, so when you reanalyze the project, existing 
elements appear as modified, deleted, or new. 

The new XML structure supports new tags and attributes and removes or 
renames existing attributes and elements to support additional information 
from LabVIEW VIs, controls, and indicators. In addition, the XML 
structure includes only elements from the front panel and block diagram if 
the element specifies traceability information that matches the expression 
for a requirement or reference element of the type.

You can still load a LabVIEW intermediate file from Requirements 
Gateway 1.0 in Requirements Gateway 1.1, but you cannot perform 
additional analysis on the file. If you want to continue to track changes to 
the traceability information in a LabVIEW intermediate file from 
Requirements Gateway 1.0, create a snapshot of the project or leave 
Requirements Gateway 1.0 installed on your computer so you can continue 
to reanalyze the old file.

The LabVIEW type includes the following new features and changes:

• Requirements Gateway can optionally analyze VI block diagrams to 
identify traceability information specified in the descriptions and 
labels of block diagram structures, functions, and wires. Diagram 
analysis is disabled by default. Select the Analyze Diagrams variable 
from the Variable ring control and enable the option in the Value 
column for the LabVIEW document on the Document Details pane of 
the Project pane of the Configuration dialog box for a LabVIEW 
document to instruct Requirements Gateway to analyze the block 
diagrams of the VIs in the document.

Note Enabling the Analyze Diagrams variable for a document increases the time required 
for Requirements Gateway to analyze the document.
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• The type supports analyzing LabVIEW project and library files. When 
you click the Add LabVIEW File button in the Select Files to Include 
in Document dialog box to add a LabVIEW file to include in the 
LabVIEW document in the Requirements Gateway project, you can 
now add .lvproj and .lvlib files.

• The Select Files to Include in Document dialog box includes a new 
Passwords button that launches the Add Password(s) dialog box, in 
which you can specify passwords that Requirements Gateway uses to 
access protected VIs. Requirements Gateway saves the passwords 
along with the document settings in the .rqtf project file.

In Requirements Gateway 1.0, Requirements Gateway prompted you 
for a password when Requirements Gateway could not access a 
protected VI. Use the Add Password(s) dialog box in 
Requirements Gateway 1.1 to specify passwords before analyzing a 
LabVIEW document to help streamline the functionality of the 
LabVIEW type.

• In Requirements Gateway 1.0, you can navigate only to VIs. 
In Requirements Gateway 1.1, you can also navigate to control 
elements of front panels and node elements of block diagrams.

• In Requirements Gateway 1.0, when you right-click an upstream 
requirement that you want a downstream LabVIEW document to cover 
and select Copy For from the context menu, you can select only 
LabVIEW Reference to create the proper syntax for a reference in 
which a VI covers the upstream requirement. 

In Requirements Gateway 1.1, you can select LabVIEW Description 
Reference or LabVIEW Text Reference to create the proper syntax for 
a reference in which the description or text of a LabVIEW control 
covers an upstream requirement. The syntax for a LabVIEW 
Description Reference and a LabVIEW Text Reference are identical, 
but the LabVIEW type formats the XML of the intermediate file in 
such a way that a LabVIEW control can have text and a description. 
You can create a custom LabVIEW type that specifies different syntax 
for description and text references.

NI TestStand
The Select Files to Include in Document dialog box includes a new 
Passwords button that launches the Add Password(s) dialog box, in which 
you can specify passwords that Requirements Gateway uses to access 
protected TestStand files. Requirements Gateway saves the passwords 
along with the document settings in the .rqtf project file.

In Requirements Gateway 1.0, this option did not exist, and Requirements 
Gateway did not load any password-protected TestStand files.
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Microsoft Word
In Requirements Gateway 1.0, the default Word type defined four levels of 
section elements to capture headings that used specific paragraph styles in 
Word, such as Heading 1, Heading 2, and so on.

In Requirements Gateway 1.1, the default Word type defines an integer 
value for the heading level that a specific paragraph style in Word specifies 
so that you can capture any level of section heading. For example, the Word 
type can capture a section element that uses a Heading 5 paragraph style, 
and the Word type recognizes the information as a fifth-level heading 
during analysis.

If you want to persist the behavior from Requirements Gateway 1.0 in 
Requirements Gateway 1.1, you can customize the default Word type in 
version 1.0 and reuse the custom type in version 1.1 instead of the default 
type. Copy the custom .types file from version 1.0 to the 
<Requirements Gateway Public>\Config\types\public 
directory in version 1.1 to reuse the custom type, which becomes available 
in the public folder in the Types List on the Types pane of the 
Configuration dialog box in version 1.1.

When you specify Word as the type for a project document, you can now 
select the following new variables from the Variable ring control on the 
Document Details pane of the Project pane of the Configuration dialog box. 
Enable the option in the Value column on the Document Details pane to 
activate the selected variable.

• With Bookmarks—Converts bookmark content to a form that 
Requirements Gateway can read and include in the analysis.

• With Annotations—Converts annotation content to a form that 
Requirements Gateway can read and include in the analysis.

• One Cell Per Line—Adds a carriage return between each column of 
a table.

The default Word type does not support Word 2007 (.docx) files, but you 
can use Word 2007 in compatibility mode to open Word 2003 or earlier 
(.doc) files. Requirements Gateway includes a new WordX type for 
capturing traceability information from a single Word 2007 file.

Note The WordX type does not support the With Annotations and One Cell Per Line 
document variables.

Microsoft Excel
You can now specify the location in an Excel document in which 
Requirements Gateway inserts traceability information. The default 
location is cell A1. 



NI Requirements Gateway Release Notes 12 ni.com

When you specify Excel as the type for a project document, you can now 
select the following new variable from the Variable ring control on the 
Document Details pane of the Project pane of the Configuration dialog box:

• Worksheet—Specifies that you want to capture traceability 
information from one or more specific worksheets in an Excel 
document. Enter the names of the sheets, separated by commas, in the 
Value column.

The default Excel type does not support Excel 2007 (.xlsx) files, but you 
can use Excel 2007 in compatibility mode to open Excel 2003 or earlier 
(.xls) files. Requirements Gateway includes a new ExcelX type for 
capturing traceability information from a single Excel 2007 file.

Microsoft Access
You can now specify that you want Requirements Gateway to analyze 
more than one table in an Access document. When you add an Access 
document to a project, the Table variable becomes available in the 
Variable column on the Document Details pane of the Project pane of the 
Configuration dialog box. Enter the names of the tables, separated by an 
exclamation point (!), in the Value column of the Document Details pane.

Microsoft Visio
The Visio type can capture traceability information from the shape data of 
a Visio 2007 drawing. Shape data in Visio 2007 corresponds to custom 
properties in Visio 2003. Refer to the Coupling Microsoft Visio with 
NI Requirements Gateway document for more information about capturing 
traceability information from shape data in Visio 2007.

Telelogic DOORS
Requirements Gateway 1.1 supports Telelogic DOORS 8.1, 8.2, 8.3, 
and 9.0 and includes a progress bar to indicate the status of exporting 
traceability information to DOORS modules.

Note Requirements Gateway supports only DOORS 9.0 on Windows Vista.

The Module name variable for the DOORS Basic and DOORS Advanced 
types is obsolete. The types now use the following new variables you can 
select from the Variable ring control on the Document Details pane of the 
Project pane of the Configuration dialog box:

• Baseline—Specifies the baseline you want to extract from the DOORS 
database. Enter the baseline in the Value column on the Document 
Details pane. You can also specify a baseline for a database in the 
Baseline control in the Select DOORS module dialog box. 
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• Server—Specifies the server you want to consider for the DOORS 
database. Enter the server name in the Value column. You can also 
specify a server for the database in the Server control in the Select 
DOORS module dialog box.

• Extract objects from—Specifies that you want to use a DOORS 
Extension Language (DXL) regular expression to extract objects from 
a DOORS module. Enter the DXL regular expression in the Value 
column. When a parent object satisfies requirements, all sub-objects 
are extracted. Refer to the Coupling Telelogic DOORS with 
NI Requirements Gateway document for more information about 
extracting objects from a DOORS module. Refer to DOORS 
documentation for more information about DXL expressions.

Refer to Chapter 10, Using NI Requirements Gateway with 
Telelogic DOORS, of the Getting Started with NI Requirements Gateway 
manual for more information about the Select DOORS module dialog box.

Code C
In Requirements Gateway 1.0, if a C-style comment block (/* ... */) 
contained a reference to a function but one or more lines, including other 
comment blocks, separated the function from the comment block, the 
Code C type associated the reference with the code file itself instead of the 
function.

In Requirements Gateway 1.1, the Code C type associates the reference 
with the function as long as no blank lines separate the comment block that 
contains the reference and the function. You can insert multiple comment 
blocks between the reference and the function, and the Code C type still 
associates the reference with the function. If any blank lines separate the 
reference from the function, or if the reference does not appear immediately 
above the function, the Code C type associates the reference with the file 
itself.

When you specify Code C as the type for a project document, you can now 
select the following new variable from the Variable ring control on the 
Document Details pane of the Project pane of the Configuration dialog box:

• Includes function body—Captures the text associated with functions 
in a C source file so that you can track changes to traceability 
information stored in the associated text. Enable the option in the 
Value column on the Document Details pane to activate this variable.
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Checksum Type
Requirements Gateway 1.1 includes a new Checksum type, which uses the 
icon shown at left. The Checksum type provides a high-level analysis of 
multiple directories and files, and does not capture any specific traceability 
information from the source files. Instead, the type stores the date and time 
of the file modifications and a Message-Digest algorithm 5 (MD5) 
signature for the file as attributes. Refer to the Checksum section of 
Appendix A, Third-Party Types Overview, of the Getting Started with 
NI Requirements Gateway manual for more information about the 
attributes of the Checksum type.

When you apply a Checksum type to a document, specify the files and 
directories for the Checksum document in the project and use the Graphical 
View to create internal coverage links to add traceability information to the 
document. Requirements Gateway creates modification documents for 
these links.

Refer to the Coupling Checksum with NI Requirements Gateway document 
for more information about using the Checksum type. You can also refer to 
<Requirements Gateway Public>\Examples\Checksum\

Checksum Example.rqtf for an example of using the Checksum type in 
a project.

Requirements Gateway and Windows Vista
The User Account Control (UAC) security component in Windows Vista 
requires administrator privileges for some tasks, such as installing 
software, running certain applications, and changing system settings. If you 
are logged in as a standard user, Vista launches a UAC elevation prompt 
for prohibited tasks. You cannot resolve the UAC elevation prompts 
programmatically. Refer to Microsoft documentation for more information 
about UAC prompts.

Other Requirements Gateway Enhancements
Requirements Gateway 1.1 includes the following additional 
enhancements:

• In the Graphical View, you can expand or collapse sections within a 
document.

• The NI Requirements Gateway User’s Manual no longer exists, and 
the content has been moved to the NI Requirements Gateway Help.

• Select Edit»Undo or Edit»Redo in the main window or in the 
Configuration dialog box to undo or redo the creation of new elements 
in a project, including attributes, reference attributes, and coverage 
links. You can also use the keyboard shortcuts <Ctrl-Z> and <Ctrl-Y> 
to perform undo and redo operations, respectively.
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• You can now generate reports in PDF and PostScript format. The 
<Requirements Gateway>\config\doc_templates directory 
contains landscape.style and portrait.style files that contain 
the format definitions for generating PDF and PostScript reports.

• The picture element can now support the PNG file format.

• Right-click a reference element in the Graphical View and select 
Add a reference attribute from the context menu to add a Boolean or 
Value reference attribute. The type that contains the reference element 
must support the reference attribute element for you to add reference 
attributes to the reference. Refer to the NI Requirements Gateway Help 
for more information about adding reference attributes and using the 
Graphical View.

• In the Requirement Details view, you can now resize and move 
columns, sort the requirements based on attribute values or 
requirement IDs, and copy and paste attribute values. When you add a 
type for added elements to a project, the Requirement Details view lists 
attributes you add for the type and contains an Added text tab on the 
Detailed Information pane so you can add text to the existing 
requirement text.

• On the Project pane of the Configuration dialog box, the Access 
column on the Document Details pane contains an HTTP option you 
can use to instruct Requirements Gateway to retrieve the source file 
from a website or FTP location using a direct HTTP connection. The 
Access column is available for types that select individual file-based 
documents. You might use the HTTP option for the Text type, Code C 
type, or a custom type that analyzes an XML file. When you select 
HTTP access, click the File Browse button in the File or Directory 
column and specify a complete URL for the file.

The Authenticated access and Proxy variables also become available 
in the Variable column. Select the Authenticated access variable if a 
password is required to access the URL of a source file. When you 
select this variable, Requirements Gateway prompts the user to log in 
while attempting to analyze the project. You can also specify the 
password directly in a URL, such as 
ftp://user:password@ftp.ni.com. Select the proxy variable if 
you must use a proxy to access shared files. When you select this 
variable, you must specify the proxy address in the Value column.

• When you include two or more documents in a folder in the 
Traceability Description Zone on the Project pane of the Configuration 
dialog box, you can now create a coverage link between the documents 
just as you can between two documents not contained in a folder. Refer 
to the NI Requirements Gateway Help for more information about 
inserting coverage links between documents and folders.
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• You can now zoom in and out on the Traceability Description Zone of 
the Project pane of the Configuration dialog box. Place the cursor in 
the Traceability Description Zone, press <Ctrl>, and scroll the mouse 
wheel up or down to zoom in or out, respectively.

• The Types List on the Types pane contains a public folder in which you 
can place types to make them available for all projects. Requirements 
Gateway saves the type definitions in the public folder in 
<Requirements Gateway Public>\Config\types\public\

public.types.

• The Types pane of the Configuration dialog box now contains the 
following tabs, depending on the element you select in the Types List:

– Analysis Tab—Options for capturing elements of the type you 
select in the Types List. The Analysis tab replaces the pane for 
standard type options.

– Advanced Options Tab—Additional options for the type. This 
tab is available only when you select the root node of a type from 
the Types List. The Advanced Options tab replaces the Advanced 
Options dialog box.

– Attributes Tab—Options for capturing attributes and specifying 
the acceptable values for the attributes. This tab is available only 
when you select the attribute element of a type in the Types List. 
The Attributes tab replaces the pane for attribute options.

• On the Snapshots pane of the Configuration dialog box, the Reports 
menu now contains a Snapshots Impact Analysis option for 
generating a report that summarizes the differences between the 
current state of the project and the selected reference snapshot, or 
between two reference snapshots, and lists the upstream and 
downstream impact of the changes.

• You can duplicate an existing filter to use as a template for a new filter. 
Right-click a filter in the Filters List on the Filters pane of the 
Configuration dialog box and select Duplicate filter from the context 
menu to create a duplicate filter.

• The Report List on the Reports pane contains a Public Reports folder 
in which you can place reports to make them available for all projects. 
Requirements Gateway saves the report models in the Public Reports 
folder in <Requirements Gateway Public>\config\
doc_models\Public Reports.xml.
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• The Options pane of the Configuration dialog box now contains the 
following tabs:

– General Tab—Options that apply to the entire Requirements 
Gateway application on your computer.

– Environment Tab—Options for specifying environment 
variables that apply only to the currently opened project.

– Project Tab—Options that apply only to the currently 
opened project.

• On the Options pane of the Configuration dialog box, the Misc section 
on the General tab now includes a Default type for directory drag 
and drop option so that you can specify a multiple-document type for 
a project directory that you drag from outside Requirements Gateway 
and drop into the Traceability Description Zone on the Project pane. 
You can specify Code, Large Code, Code C, or Multi Word as the type 
for the directory.
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